UHV Student Help for Blackboard:

A majority of the Blackboard issues experienced by users can be resolved by following the step-
by-step procedures outlined below. Please follow the steps outlined in this document to resolve
your Blackboard issues. If you still experience Blackboard issues after completing these steps,
please contact your UHV Blackboard Online Support Technician (Blackboard Contact Us Page).
For assistance after normal working hours, please complete the Blackboard Online Support

Request Form.

Test your browser configuration by following the steps in the checklist presented below:

1.

Is Your Browser Supported?
Click here for a complete list of Blackboard-compatible internet browsers. The most
popular Blackboard browsers include the following:

Internet Explorer (http://www.microsoft.com/windows/ie/)
Mozilla Firefox 3.5.X(http://www.mozilla.com/en-US/firefox/firefox.html)
Safari (for Mac users; http://www.apple.com/safari/)

1.1

To confirm your browser is configured properly, click on the Blackboard Tuneup
Page link and follow the instructions on the screen.

Have You Disabled the Browser’s Pop-Up Blocker?

Blackboard uses pop-ups to present course material. If any pop-up blockers are present
on your system, they will prevent you from seeing course content. Follow the
procedures below to disable your browser’s pop-up blocker feature.

2.1
2.2

2.3

2.4

2.5

Open Internet Explorer.
Click on the Tools menu and mouse over to the Pop-up Blocker option.

For IE7 (or higher) users, make sure you are selecting the “main menu” Tools
option. You may need to press the Alt button on your keyboard for the menu
options to appear in the browser.

A tiny menu should expand to the right. Click on the Turn Off Pop-up Blocker
option.

If the option for the pop-up blocker is not present, your version of Internet Explorer
may not have this feature or you have already disabled this feature.

For specific instructions to disable pop-up blockers for other browsers, please visit
the manufacturer’s main webpage (see links below).

Mozilla Firefox (http://www.mozilla.com/en-US/firefox/personal.html)
Safari (for Mac users; http://www.apple.com/safari/)



http://www.uhv.edu/blackboard/contactus.asp
http://www.uhv.edu/blackboard/supportrequest/
http://www.uhv.edu/blackboard/supportrequest/
http://www.webct.com/tuneup/viewpage?name=tuneup_browsers_vista80_ce80
http://www.microsoft.com/windows/ie/
http://www.mozilla.com/en-US/firefox/firefox.html
http://www.apple.com/safari/
http://www.webct.com/tuneup/
http://www.webct.com/tuneup/
http://www.mozilla.com/en-US/firefox/personal.html
http://www.apple.com/safari/

Have You Added the UH.EDU Domain to Your

List of Privacy Sites?

Follow the procedures described below to add the UH.EDU domain information to your
list of privacy sites in Internet Explorer 6 and Internet Explorer 7 (refer to the original
manufacturer’s instructions for other browsers).

3.1
3.2

33
3.4

3.5
3.6

3.7

3.8

Open Internet Explorer (applies to IE6 and IE7 users).
Click on the Tools menu () and select the Internet Options feature

(LInternet Options |),

For IE7 (or higher) users, make sure you are selecting the “main menu” Tools
option. You may need to press the Alt button on your keyboard for the menu
options to appear in the browser.

A new dialog box should appear. Click on the Privacy tab (.73 ),

Click once on the Sites button (see below).

|

A new Per Site Privacy Actions dialog box should appear.

In the Address of website field area of the Per Site Privacy Actions dialog box, type
in the following UH.EDU domain information (see below).

Address of website:

uh.edu
| Allow I

Click once on the Allow button (IE). The UH.EDU domain information
should now appear in the Managed websites area of the Per Site Privacy Actions
dialog box (see below).

Managed websites:

Domain Setting
uh.edu Always Allow

Click once on the OK button (E) to close the Per Site Privacy Actions
dialog box. Click OK again to close the Internet Options dialog box.



Have You Added the Blackboard Web Address to Your
List of Trusted Sites?

Follow the procedures described below to add the various UHV, “scholar,” and “learn”
website addresses to your list of trusted sites in Internet Explorer (refer to the original
manufacturer’s instructions for other browsers).

4.1 Open Internet Explorer.
4.2 Click on the Tools menu () and select the Internet Options feature

( Internet Options ).

For IE7 (or higher) users, make sure you are selecting the “main menu” Tools
option. You may need to press the Alt button on your keyboard for the menu
options to appear in the browser.

4.3 A new window should appear. Click once on the Security tab.

4.4 Click once on the Trusted sites option in the zone selection window (see below).
Select a zone to view or change security settings,

WA

Internet  Local intranet QUOEGHESWES —Restricted
sites

Sites

4.5 Click once on the | | button.
4.6 A new window will appear.
4.7 Uncheck the “Require server verification...” option right below the Websites

selection window (see below).

B Require server verification (https: For all sices in this zone

4.8 In the zone field, type in each of the addresses below and click the

button.

Add this website to the zone:
http: ffwww,uhy. eduf* Add

If Windows prompts you with a message that the site must exist in the Local

Intranet Zone, click to move it to the Trusted Sites Zone.

Add this website to the zone:

http:/flearn.uh.eduf*

Add this website to the zone:
file:/f*.uhv.edu Add




4.9 When you’'ve added the website addresses above, the Websites selection window
should look like the example presented below.
|Webskes: ‘

file: /" uhv edu

http://learn.uh edu

hitp: /Awww. uhv. edu

4.10 Click the button once. Click the button to close the

Internet Options dialog box.
4.11 For specific instructions to add trusted sites to other browsers, please visit the
manufacturer’s main webpage (see links below).

Mozilla Firefox (http://www.mozilla.com/en-US/firefox/personal.html)
Safari (for Mac users; http://www.apple.com/safari/

5. Have You Cleared the Java Cache?
When you clear your browser’s cache, it’s a good idea to clear the Java cache as well.
Clearing the Java cache ensures a new Blackboard connection when you browse to the
Blackboard site. Note the web pages may take a little longer to display after clearing the
browser and Java cache.

5.1 Open the Java (JRE) control panel by selecting the Start + Settings + Control Panel
options.

Optional: Windows XP users may need to change their Control Panel setting to the
“Classic View” by selecting the “Switch to Classic View” option.

5.2 Double-click on the Java icon (1=2/7a¥a ). A new dialog box should appear.

5.3 Locate the Temporary Internet Files section and click the SEHNGS.hutton
once.
5.4 Click the Delete Fies. . | button once to delete the Java files. A new dialog box

may appear asking you to confirm that you want to delete the Applications and
Applets and Trace and Log Files. Select both checkboxes if possible and click the

(] 4
button once.

5.5 Click I| to close the Java dialog box.

If you don’t have Java installed, click here to download and install the Java (JRE)
environment on your PC.



http://www.mozilla.com/en-US/firefox/personal.html
http://www.apple.com/safari/
http://www.java.com/en/download/index.jsp

6.

Have You Cleared Your Browser’s Cache, Cookies, Temporary Files,

and History?
This is a useful troubleshooting step if you experience trouble logging into Blackboard.

6.1
6.2
6.3

6.4
6.5

6.6
6.7

Open Internet Explorer.

Click Tools + Internet Options from the menu selection items.

On the General tab locate the Temporary Internet Files section and click once on
the Delete Cookies option. This deletes all cookies installed from other websites.

IE7 users can select the button in the Browsing History section and

then select the Delete all... button + & Also delete files and settings stored by add-ons. |

to delete all of the browsing information.

IE6 users can click the Delete Files option + OK to delete all the files stored in cache.
IE6 users can click the Clear History + Yes option under the History section to delete
all the stored history items.

Click OK to exit the Internet Options window.

For specific instructions to clear the cache and history for other browsers, please
visit the manufacturer’s main webpage (see links below).

Mozilla Firefox (http://www.mozilla.com/en-US/firefox/personal.html)
Safari (for Mac users; http://www.apple.com/safari/

Have You Disabled Toolbar Tool Pop-up Blockers?

In addition to the browser pop-up blocker, there are toolbar tools that may contain their
own version of pop-up blockers, which could prevent you from accessing your
Blackboard content.

7.1
7.2
7.3

74
7.5

7.6

7.7
7.8

7.9

Open Internet Explorer.

Click on the View menu and mouse over to the Toolbars menu.

A small sub-menu should appear to the right. Note the contents of the sub-menu.
They may be: AOL Toolbar, Yahoo Toolbar, MSN Toolbar, etc.

If any of these are present, we recommend un-installing them.

To un-install these Toolbars, click Start + Control Panel (or Start + Settings + Control
Panel, depending on your version of Windows).

Click on the Add or Remove Programs icon.

Find the names of the Toolbars noted in the previous step and un-install them.

If the Toolbar name isn’t available from the Add or Remove Programs menu list,
then go back into Internet Explorer, select View + Toolbars, and uncheck any
remaining Toolbars (click on the name within the menu listing). This may only
disable the Toolbar.

For specific instructions to disable Toolbar pop-up blockers for other browsers,
please visit the manufacturer’s main webpage (see links below).


http://www.mozilla.com/en-US/firefox/personal.html
http://www.apple.com/safari/

Mozilla Firefox (http://www.mozilla.com/en-US/firefox/personal.html)
Safari (for Mac users; http://www.apple.com/safari/)

8. Have You Disabled the IE7 Phishing Filter?
It’s possible the IE7 phishing filter may cause issues with Blackboard. Follow the
procedures described below to disable it.

8.1 Open Internet Explorer.
8.2 Select the Tools + Internet Options feature.
8.3 Click once on the Advanced tab and scroll down to locate the Security section
(should appear with a “lock” icon next to the text in the list; see below).
ﬂ Security H
Alloww ackive content From COs ko run on My Compuker®
B Allow active content to run in files on My Computer®
B Allow software ta run or install even i the signakure is inva
Check Far publisher's certificate revacation
B check for server certificate revocation®
Check Far signatures on downloaded programs
B 0o not save encrypred pages ko disk
@ Empty Temporary Internet Files Folder when browser is cf
Enahle Inteqrated Windows Authentication®
Enable native ¥MLHTTP suppart
g Phishing Filter
@ Disable Phishing Filker
@ Turn off automatic website checking
8.4 Select the Disable Phishing Filter radio button option to disable the feature.
8.5 Click OK to close the Internet Options window.
8.6 For specific instructions to disable phishing filters for other browsers, please visit
the manufacturer’s main webpage (see links below).

Mozilla Firefox (http://www.mozilla.com/en-US/firefox/personal.html)
Safari (for Mac users; http://www.apple.com/safari/)

If you continue to experience problems accessing Blackboard, please contact your UHV
Blackboard Online Support Technician (Blackboard Contact Us Page). For assistance after normal
working hours, please complete the Blackboard Online Support Request Form. You can also
contact the UHV IT Help Desk at 361-570-4399 or HelpDesk@uhv.edu for additional
troubleshooting assistance.



http://www.mozilla.com/en-US/firefox/personal.html
http://www.apple.com/safari/
http://www.mozilla.com/en-US/firefox/personal.html
http://www.apple.com/safari/
http://www.uhv.edu/blackboard/contactus.asp
http://www.uhv.edu/blackboard/supportrequest/
mailto:HelpDesk@uhv.edu

